
Editing your audio.

This lesson will demonstrate some different techniques for cleaning up and putting finishing touches on
your audio to make it appear more professional.

1. Loading your audio file.

To load your file, you can either record your own (see the lesson titled "Recording audio out from your
computer" if you need more info), or open an audio file already that has been saved.

To open a file go to the "File" menu at the top and select "Open...".
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Once you've selected "Open" this window will pop up. Find the file you'd like to edit, click on it and then
click "Open". This will open the audio file and place it into Audacity's work area so that it can then be
viewed and modified. Files that Audacity can't read will be grayed out (note that there is a decent
variety of formats which audacity can read).

If you wish to filter what types of files appear in the window for choosing what to open, go to the bottom
of the window and click on the drop-down menu and select the type of file you are looking for.
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2. Playback, adjustment, and editing controls panel.

This is your main control panel with the basic viewing, playing, and editing components in Audacity.

1.  Tool Selector:  This is where you select the tools that you use to directly modify specific parts of your
audio tracks.
2.  Playback Controls:  These are the playback controls so you can view/review your audio.
3.  Edit and Viewing Controls: These are your basic editing (such as cut and paste and zoom) controls.
4.  Output and Input Meters:  These show how loud the audio that is being played or being recorded is
at that moment.
5.  Output and Input Sliders:  These show what the output and input volumes are set to. (Depending on
your system and hardware, you may be able to adjust both right there in Audacity... otherwise you will
have to go to the system control panels for sound to adjust them.)
6.  Input Source Selector:  this allows you to select what source to use when you start recording (such
as a microphone, or your Audio-in line)
7.  Timeline:  This shows where audio stops and starts in your project. The increments shown will
depend on what level of zoom you are at (here they are shown at one second increments).

- The Work Area.

Below the controls panel is the Work Area. This area is comprised of audio tracks which are made of
one (Mono) or two (Stereo, one for left and one for right) channels. 
The track has a few controls (however for the most part you don't want to change these);
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1- Delete and Option menu:  Clicking the X will delete the track and the channels with it, the drop down
menu shows the name of the track and has options such as changing the name of the track, combining
or splitting the channels, appearance, and a few other options.
2- Track information:  Shows the playback settings of the track. Clicking in this area will select the entire
track.
3- Mute/Solo:  Clicking "Mute" will silence this track when you use the playback controls. Clicking "Solo"
will mute all the other tracks in the project.
4- Gain Slider:  This will increase or decrease how loud the track is... however moving it too far can
cause distortion.
5- L/R Pan:  This slider will change how much is played out of the left or right speakers. If it's a stereo
track it means how much of the corresponding channel will be played over the other (IE if it's set all the
way to left it will only play the left channel, and vice versa)

This example shows a Stereo track that has a left channel (6) and a right channel (7). The channels are
to the right of the Track information and extend to the edge of the window.

A channel is shown using a waveform (8), which is the visual presentation of the audio data. The
waveform is what you will edit and modify most of the time to get the effect you desire in your audio.

The vertical line near the end of the example (9) is the playback indicator.  This shows where Audacity
will begin playing from, as well as use as a reference point for copying and pasting.

- Tool Selector.

These are your tools that you use to select and modify parts of your audio. Going from left to right, top
to bottom;

- Selection Tool (Text cursor): This is your default selection, and allows you to select all or part of your
audio by clicking and dragging along the waveform, which will then be darkened to indicate it has been
selected (1). Once a portion has been selected, you can then edit, play, delete (simply push the delete
key), or copy it. This tool also allows you to place the playback indicator at different points in your
project.
- Envelope Tool (Vertical arrows): This tool allows you to change the loudness of specific parts of your
audio. When this tool is selected a blue-purple bar will appear on the top and bottom of the channel (2
and 3) that you can add points to by clicking on it, with which you can then drag up and down to change
the loudness at that spot.
- Draw Tool (Pencil): This tool allows you to modify the waveform itself (4), however this is time
consuming as you have to greatly zoom in on the wave form until you can see the individual points on it
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and then move the points one a time to get what you want. This is for more advanced users, so you
probably won't need to use this tool at all.
- Zoom Tool (Magnifying Glass): This allows you to zoom in on a specific location of the wave form by
clicking on it. To zoom out, simply hold "shift" down and click on the waveform. 
- Time Shift Tool (Left-right arrows): This allows you to slide a track left or right on the timeline, which is
useful if you are using more than one track in your project. when this tool is selected two bars will
appear at each end of the channel (5 and 6) which you can click and drag left or right to move the track.
- Multi-Tool (Star):  This tool combines all the tools (except the zoom tool) into one tool, quite handy if
you are switching between tools often.

(See the example below for references)

- Playback Controls.

These are the controls that let you review your audio so you may know where to make changes if you
need to. If you have certain portion of  the audio selected, it will only play that portion. As audio is being
played there will be a vertical line through your project with an arrow at the corresponding spot of the
timeline that shows what part is being played. Description of the controls from left to right;

- Skip to start: Moves the play indicator to the beginning of the track.
- Play: Starts playing the audio where the play indicator is. If there is no play indicator visible, it will start
playing from the beginning of the track or the selection.
- Record: This will start recording from your input source (this is generally by default set to your
microphone line-in). You will need audio playing through your input source while recording is going.
When you record, Audacity will make a new track and start creating a waveform following the play
indicator.
- Pause: This will pause the play indicator while playing or recording, push pause again to resume.
- Stop: This will stop the play indicator and reset it.
- Skip to end: This will move the play indicator to the end of the track.
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- Edit and Viewing Controls.

These are your basic editing controls and are very similar to editing controls found within text programs
such as Microsoft Word or Notepad.
Cut:  This will copy then delete the selected portion of the waveform.
Copy:  This will copy the  selected portion of the waveform.
Paste: This will paste the last copied selection into the wave form, either to replace a selected area or
to insert after where the play indicator line is.
Trim outside of selection:  This deletes everything in the channel outside the selected area.
Silence selection:  This causes the selected area to go completely silent, and will appear as a flatline on
the waveform.

Undo:  Undoes your last action. You can do multiple undoes.
Redo:  Cancels your last undo.

Zoom In:  Zooms the view in a step.
Zoom Out:  Zooms the view out one step.
Fit selection to window:  Zooms the view to what you have selected to be within the window.
Fit project to window:  Zooms the view so that all of your project is within the window.

Note: If you want to delete a selection just push backspace or delete.

3. Modifying using Effects.

Once you have just  the audio you want (and where you want it) in your project, it's time to make
finishing touches or further modifications beyond the simple editing controls found on the controls
panel.  Effects add more modification options beyond the basic controls, and can really help make a
piece sound even more professional. Effects can also cut down the time it takes to get your audio to
how you want it to be, and so in some cases they provide an alternative solution.
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-Fade in/Out

When you want to your audio piece to ease in softly to the main portion and/or end softly, you will want
to use the fade in and out effects. Fade will gradually change the loudness between nothing and what
your audio is set to over the course of the selection. If you choose fade in then it will start at zero and
ramp up to normal, and vice versa for the fade out (starts at normal and drops off to zero).
To apply the fade;
- Select the portion of the waveform you want affected (usually it's the beginning or the end).
- Go to the "Effect" menu and choose the fade you want.
You now have your fade effect.
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-Noise Removal

If you have a piece of audio that has an annoying hum, hissing, or crackling in the background that you
want to get rid of, you will want to use Noise Removal to fix it.
Using Noise Removal is a two-step process;
- First, select a part of the audio that only has the noise you want eliminated. 
Important Note:  Make sure that portion of audio selected has only the noise you want eliminated and
nothing else, otherwise you'll eliminate more than just the background noise.

- Go to the "Effect" menu and select "Noise Removal...".
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This will bring up the Noise Removal window. 
- Then click "Get Noise Profile" (1).
- Close the Noise Removal window.
- Select the part where you can distinctively hear the noise you want to remove. Most times, it will come
from the beginning of the recording.
- Reopen the Noise Removal window.
- Adjust how sensitive you want the removal to be (2). The more sensitive it is the less other sounds it
will remove... but you are more likely to still get some of the annoying sound left behind, where as less
sensitive is the opposite; it will get rid more of the annoying sound but has a chance of getting rid of
other sounds too (you can preview how it will sound like by clicking "Preview"[3] before committing).
- Click "Remove Noise"(4).
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Once that is done you can close the Noise Removal window, and there shouldn't be any of the sound
that was eliminated in the selected portion of the audio.

-Normalize

Ever listened to a bunch of songs and had one that was too loud followed by one that was too quiet? 
To avoid doing things like that, then you will most likely want to use Normalize to make your audio's
volume be closer to a standard (in case if your audio piece is a little too loud or a little too quiet). This is
great because it means you don't have to go adjust your volume settings and re-record or mess around
with the gain and envelope tools to get what you want.
To do this;
- Go to the "Effect" menu and choose "Normalize"
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This will open up the Normalize window.
- Make sure both boxes are checked.
- Click "OK".

Audacity will then adjust the selected area in relation to its loudest point, which will be adjusted so it
that the wave form will be just under from touching the edges.

There are quite a few more effects that you can use for various things that haven't been covered,
however the ones covered here should enable you to make edits to your audio that will allow them to
present clean and crisp. Good luck with making your audio files.
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